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Installing Oracle VM VirtualBox on Windows 7 
This experiment shows how to install VirtualBox and the Extension Pack to enable the use of a Linux 
virtual machine for the cross build platform. 
 
General Instruction: 
Install Oracle VM VirtualBox using the official VirtualBox installer.  For legal distribution reasons, the 
VirtualBox installation executable cannot be included with any public Avnet materials.  To obtain a free 
legal copy of the Oracle VM VirtualBox and the Extension Pack, please download from the VirtualBox 
website: 

https://www.virtualbox.org/wiki/Downloads 
 
The version downloaded may differ from the version shown in this documentation (4.3.20).  Be sure to 
read the VirtualBox EULA to ensure you do not violate the Personal Use and Evaluation License (PUEL).  
You may also wish to consult the VirtualBox Licensing Frequently Asked Questions for a quick overview 
of the intent of the license agreements: 
 

https://www.virtualbox.org/wiki/Licensing_FAQ 
 
 
Step-by-Step Instructions: 

1. To obtain a free legal copy of Oracle VM VirtualBox, download the installer from this website: 

https://www.virtualbox.org/wiki/Downloads 
 

The version downloaded may differ from the version shown in this documentation (4.3.20).  You 
will also need to download the Extension Pack as well.  Make sure the Extension Pack you 
download is the same version as your VirtualBox installer.   
 

2. Launch the VirtualBox installer from Windows Explorer by double-clicking on the self-extracting 
executable.  Allow the installer to make changes to your computer, if so prompted. 

 
Figure 1 – VirtualBox installer for Windows 

  

https://www.virtualbox.org/wiki/Downloads�
https://www.virtualbox.org/wiki/Licensing_FAQ�
https://www.virtualbox.org/wiki/Downloads�
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3. Once the VirtualBox installation wizard appears, click on the Next button.  

 
 

Figure 2 – VirtualBox Installation Wizard Welcome 
 

4. You may accept all the installation defaults, although you may wish to change the installation 
location on your development platform using the Browse button.  If the options are acceptable, 
click the Next button. 

 

Figure 3 – VirtualBox Custom Setup 
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5. You may again accept the default options and click the Next button. 

 
 

Figure 4 – VirtualBox Custom Setup Options 
 

6. Click the Yes button to continue with the installation wizard. 

 
 

Figure 5 – VirtualBox Network Interfaces 
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7. Click the Install button to load VirtualBox to your development system.   

 
 

Figure 6 – VirtualBox Ready to Install 
 

8. During the installation you may receive prompts to authorize installation of various 
components.  If prompted, allow the installer to make changes to your system, including 
installation of the USB interface and Network adapters. 

 
 

Figure 7 – VirtualBox Installation 
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9. Click the Finish button to complete the installation.  Leave the checkbox enabled so VirtualBox 
will start after the installer finishes. 

 
 

Figure 8 – VirtualBox Installation Complete 
 

10. Once VirtualBox starts (you can also start it from the Desktop shortcut, or the Windows Start 
button), the Extension Pack must be added.  From the main menu, select File -> Preferences. 

 

 
 

Figure 9 – VirtualBox First Startup 
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11. Select Extensions.  Right-click in the Extension Packages whitespace box, and select Add 
package. 

 

 
 

Figure 10 – Add Extension Pack 
 

12. Browse to the location where you downloaded the VirtualBox Extension Pack compatible with 
your VirtualBox version.  Select the Extension Pack and click the Open button. 

 

 
 

Figure 11 – Select the Compatible Extension Pack 
 

13. Click the Install button to add the VirtualBox Extension Pack. 
 

 
 

Figure 12 – Install the Extension Pack 
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14. Read the VirtualBox Extension Pack PUEL License to ensure you will not be in violation of the 
Oracle definition of Personal Use (See the VirtualBox Licensing Frequently Asked Questions for 
additional details).  If you can accept the license conditions, click the I Agree button1

 

.  If 
prompted, allow the installer to make changes to your development system. 

 
 

Figure 13 – Extension Pack License Agreement 
 

15. Click the OK button to complete the installation. 
 

 
 

Figure 14 – Extension Pack Installation Complete 
 
  

                                                           
1 If you must disagree, the installation will be terminated.  You should either purchase a commercial license or 
uninstall VirtualBox from your host computer. 
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16. Click the OK button to return to VirtualBox. 
 

 
 

Figure 15 – VirtualBox Extension Pack Installation Complete 
 
 
 

This completes the installation of VirtualBox on your host development system.  VirtualBox is now ready 
to accept a new Virtual Machine.  
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Create a New Virtual Machine 
 

1. Launch VirtualBox and click the New icon at the upper left. 

 
 

Figure 16 –Create a New Virtual Machine 
 

2. Select a descriptive name for the VM.  Set the Type to Linux and the Version to Red Hat (64 bit). 
Click the Next button. 

 
 

Figure 17 – Set the Virtual Machine Name 
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3. Select the amount of memory to be allocated to the Virtual Machine.  Allocating more memory2

 

 
will improve the VM performance, but you must leave sufficient memory available for your host 
system for all other concurrent processes.  For a host system with 16 GB of RAM, a value of 2048 
MB is recommended for the Virtual Machine.  You may wish to experiment with this value to 
optimize your performance.  Once you have selected a memory size, click the Next button. 

Figure 18 –Select a VM Memory Size 
 

4. Click the Create3

 

 button to allocate a virtual hard drive now. 

Figure 19 – Create a Virtual Hard Drive 
 

                                                           
2 You may need more memory if you intend to run Vivado with large Xilinx devices. 
3 If you are importing an existing Virtual Machine, click the “Use an existing…” button.  
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5. Click the Next button to accept the default file type for a VirtualBox Disk Image. 

 

Figure 20 – Set Virtual Disk Type 
 

6. Select Fixed Size for the physical storage on your host hard drive.  This will improve overall 
performance of the Virtual Machine.  Click the Next button. 

 

Figure 21 – Set Virtual Disk Storage 
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7. Select the name and location for the Virtual Machine within your host file system.  It is 
recommended that the default size be set at 40.0 GB to accommodate the Xilinx tools.  If this 
space is unavailable, 20.0 GB is sufficient if you plan to install only the Software Development Kit 
and not Vivado.  Click the Create button. 

 

Figure 22 – Create Virtual Hard Disk 
 
The Virtual Hard Disk may take a few minutes to create and initialize on your host file system. 
 

 
 

Figure 23 – Virtual Hard Disk Creation 
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8. Once the Virtual Disk completes, your VM is ready to accept an operating system.   

 

Figure 24 – Virtual Hard Disk Creation Complete 
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Install the CentOS Operating System 
 
To perform the steps in this section, you will need to download a bootable OS image in .iso format to 
your host system.  The most recent CentOS images can be downloaded from: 
 

 
http://www.centos.org/download/ 

For the Xilinx 2014.4 tools, the latest version of CentOS officially supported by Xilinx is CentOS 6.5.  You 
may locate a mirror to download the CentOS-6.5-x86_64-bin-DVD1.iso image at : 
 

http://vault.centos.org/6.5/isos/x86_64/CentOS-6.5-x86_64-bin-DVD1.iso 
 

1. Launch VirtualBox (if necessary) and select the VM you wish to start in the left-hand panel.  Click 
the Start arrow icon to execute the VM. 

 

Figure 25 – Launch the New VM 
 

2. Your VM may issue one or more warning messages similar to the one shown below.  In most 
cases these will not impact the operation required for creating a PetaLinux development 
environment, and you may click the OK button.  Correcting such issues is machine-dependent 
and is beyond the scope of this document. 

 

Figure 26 – Startup Warning Message(s) 

http://www.centos.org/download/�
http://vault.centos.org/6.5/isos/x86_64/CentOS-6.5-x86_64-bin-DVD1.iso�
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3. Select the Browse icon to locate the .iso image for the OS you wish to install on your Virtual 
Machine.  Click the Start button to begin. 
 

 
 

Figure 27 – Select VM OS Image 
 

Proceed with section Install CentOS 6.5 or section Install CentOS 7.  Note that for Xilinx 2014.4 
tools, CentOS 7 is not officially supported. 
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Install CentOS 6.5 
1. Select the option (default) to install and hit the Enter key.  Note that during the installation you 

can recapture the cursor in Windows by pressing the Right Ctrl Key. 

 

Figure 28 – CentOS Installation Initiated 
 

2. You can choose whether to check the integrity of your installation media or not.  If you have 
used it for prior VMs, it is likely OK.  Hit the Enter key to select OK and test the media or use the 
right arrow keyboard key to select the Skip button and hit the Enter key to bypass. 

 

Figure 29 – Test Installation Media 
 

Following the media test, your virtual installation disk may be ejected.  If this happens, from the 
main VirtualBox menu select Devices -> CD/DVD Devices -> Choose a virtual CD/DVD disk file 
and browse once again to your .iso image. 
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3. Click the Next button in the lower right corner of the installation Splash Screen. 

 

Figure 30 – CentOS Installation Splash Screen 
4. Select the local language and click the Next button. 

 

Figure 31 – Language Selection 
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5. Select the keyboard corresponding to your host system and click the Next button. 

 

Figure 32 – Keyboard Selection 
 

6. Select Basic Storage Devices and click the Next button. 

 

Figure 33 – Storage Selection 
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7. Since this is a new virtual hard drive, there is no data to be salvaged.  Click the Yes button to 
discard any data. 

 

Figure 34 – Data Disposition 
 

8. Select a name for the Virtual system and click the Next button. 

 

Figure 35 – Virtual System Name 
 

9. Select the time zone for your virtual system and click the Next button. 

 

Figure 36 – Time Zone Selection 
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10. Enter a root password for the system and make a note of it.  You will need this for tool 
installation later.  The root password must be 6 characters or more.  Click the Next button. 

  

Figure 37 – Select Root Password 
 

 For testing purposes the root password used was “AvnetLinux”, but you should select a stronger 
password for enhanced security. 

 

11. Select the option to Use All Space on the new virtual disk, and click the Next button. 

 

Figure 38 – Disk Space Disposition 
 

12. Confirm that your selections are correct by clicking the Write changes to disk button. 

 

 
Figure 39 – Create the Virtual Disk 
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13. Select the installation type for the Virtual Machine.  To avoid compilation problems when 
installing the Guest additions later, it is highly recommended to choose Software Development 
Workstation.  Click the Next button. 

 

Figure 40 – Select System Type 
 

14. The installation will take several minutes or more to complete. 

 

Figure 41 – OS Installation in Progress 
 

When the software installation completes, click the Reboot button at the lower right. 

 

Figure 42 – Reboot  
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15. The OS installation is complete at this point, but the system still requires first-time 

configuration.  Click the Forward button to continue. 

 

Figure 43 – OS Configuration Splash Screen  
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CentOS 6.5 First Time Configuration 
 

1. To complete the installation, you must agree to the License conditions.  To proceed, select the 
“Yes…” option and click the Forward button. 

 

  
 

Figure 44 – Accept the OS License Agreement 
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2. You must create a standard user account to regularly log in to the Linux system.  Enter a 
username and password information in the appropriate text boxes on this panel.  You may 
select any valid username and password;  the example shown here creates a user account for 
“training”.  Click the Forward button. 

 

Figure 45 – Create Standard User Account 
 

For testing purposes, the training user was assigned the password “Avnet”, but you should 
select a stronger password for enhanced security. 
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3. Allow Linux to synchonize it’s system clock over the Internet by checking the”Synchronize…” 
box.  Click the Forward button. 

 

Figure 46 – Synchronize System Time 
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4. Kdump decreases system performance and it is unlikely to be needed in the virtual machine.  
Ensure the “Enable kdump” box is unchecked and click the Finish button. 
 

 

Figure 47 – Disable kdump 
 

5. Click the Yes button. 
 

 

Figure 48 – Enable System Reboot 
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6. Click the OK button to reboot the system and complete the OS setup. 

 

Figure 49 – System Reboot 
 

7. After the system reboots, you may log in to Linux using the standard user account credentials 
created earlier in this section. 

 

Figure 50 – Log In as Standard User 
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Install CentOS 7 
 

1. Select the option (default) to Install CentOS 7 and hit the Enter key.  If desired, you may move 
between options using the up/down arrow keys.  Note that during the installation you can 
recapture the cursor in Windows by pressing the Right Ctrl Key. 

 

Figure 51 – CentOS 7 Initial Installation Screen 
 

2. Select your language using the mouse and click the Continue button. 

 

Figure 52 – CentOS 7 Initial Installation Screen 
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3. You must complete any sections marked with the    icon before proceeding.  However, you 
may want to adjust a number of other sections as well.  These adjustments are included in the 
following sub-bullets.   

 

Figure 53 – CentOS 7 Installation Settings 
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a. Click the Network & Hostname entry.  In the new panel, click on the button next to the 
OFF indicator (highlighted) at the upper left to turn networking ON. 

 

Figure 54 – Activate Networking 
 
Click the Configure button in the panel.  Click the checkbox to Automatically connect… 
Click the Save button to make the setting permanent.   
 

 
 

Figure 55 – Automatically Connect Network Interface 
 
Click the Done button at the upper left of the Network & Hostname panel to return 
to the Installation Settings screen. 
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b. Click on the Date & Time entry.  Select your time zone by clicking on the appropriate 
section of the world map.  You can also choose to set your clock to an NTS server by 
turning the Network Time on by clicking on the slider button at the upper right. 

If you wish you can also set the date and time of day manually by using the controls 
provided at the bottom of the panel. 

 

Figure 56 – Time and Date Selection 
 

Click the Done button at the upper left to return to the Installation Settings screen. 

  



VirtualBox and VM Creation  Vivado®/SDK 2014.4 
 

 
 33 February 2015 

c. Click on the Software Selections entry.  By default, a minimal installation is selected 
which provides only a command line interface.  You probably want a desktop for ease of 
use, so the recommendation is to select GNOME Desktop4

 

.  This will populate the Add-
Ons panel with additional options.  At a minimum you should select the GNOME 
Applications, Legacy X-Window System Compatibility and Development Tools here.  

Figure 57 – Software Selection 
 

Click the Done button to return to the Installation Settings screen. 

  

                                                           
4 If you would like a more extensive set of development tools, you can select Development and Creative 
Workstation. 
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d. Click on the Installation Destination entry.  As this is a new installation, there is no need 
to make any changes here.  You can allow the system to automatically partition the 
entire space previously allocated for your Guest OS hard drive.  Ensure the 
Automatically configure partitioning option is selected, and click the Done button to 
return to the Installation Settings Screen. 

 

Figure 58 – Virtual Disk Partitioning Options 
 

4. In the Installation Settings screen, click the Begin Installation button at the bottom right. 

 

Figure 59 – Start CentOS 7 Install Script 
 

5. As the installation process begins, you will see on the next panel that there is no root password 
and no user account.  You can set both of these while the installation is going on. 

 

Figure 60 – Configure User Settings 
 

a. Click on the ROOT PASSWORD entry.  Enter and confirm the root password you wish to 
use for your CentOS installation.  If your password does not meet the strength test, you 
will need to click the Done button twice instead of once to exit. 

  
Figure 61 – Set root Password 
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b. Click on the USER CREATION entry.  Enter an account (user) name and password for the 
account.  If you wish, you may uncheck the Require a password… box to remove the 
password requirement from the user account.  Click the Done button (twice if your 
password is weak) to confirm the settings. 

 

Figure 62 – Set Standard Account and Password 
 

6. When the installation completes, click the Reboot button at the bottom right of the screen to 
continue. 

 

Figure 63 – Reboot 
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CentOS 7 First Time Configuration 
 
This section assumes you have just completed a system reboot following CentOS installation. 
 

1. The first panel to appear is the INITIAL SETUP screen.  You must accept the License Agreement 
before configuration can be completed. 

 

Figure 64 – License Agreement 
 

a. Click on the License Information entry.  The next panel indicates where license 
information can be found in the distribution.  Once you are satisfied with the licensing 
material, check the I accept… box and click the Done button at the upper left. 

 

Figure 65 – Accept License 
 

2. Click the FINISH CONFIGURATION button at the lower right. 

 

Figure 66 – Finish Configuration 
 

3. Kdump is typically not required for a virtual machine, and uses memory that could otherwise be 
allocated to operational tasks.  Uncheck the Enable kdump button and click the Forward button 
at the lower right to continue. 

 

Figure 67 – Disable Kdump 
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4. Click the Yes button to allow for a reboot after configuration completes. 

 

Figure 68 – Allow Reboot 
 

5. Click the OK button. 

 

Figure 69 – Reboot the Virtual Machine 
 

6. After the system reboots, you may log in to Linux using the standard user account credentials 
created earlier in this section. 

 

Figure 70 – CentOS 7 Virtual Machine 
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7. The GNOME desktop has a few more initial setup screens to finalize the user account on the first 
login.   Select your default language and click the Next button. 
 

 
 

Figure 71 – CentOS 7 User Account Default Language 
 

8. Select your default keyboard input and click the Next button. 
 

 
 

Figure 72 – CentOS 7 User Account Default Keyboard 
9. Cloud setup is beyond the scope of this tutorial.  Click the Next button to skip cloud setup. 
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Figure 73 – Skip Cloud Configuration 
 

10. Click the Start using CentOS Linux button to complete the first time setup and view the desktop. 
 

 
 

Figure 74 – Account Configuration Complete 
 

 
 

Figure 75 – CentOS 7 Default Desktop 
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VirtualBox Guest Additions Installation (File Sharing) 
 

1. The use of shared folders allows for easy transfer of files between the host and guest systems.  
To use the shared file facility of VirtualBox, you must install the Guest Additions.  If you attempt 
to use the shared folder facility without the Additions, you will receive the following error 
message. 

 

 
 

Figure 76 – VirtualBox Guest Additions Missing 
 
After Guest Additions are installed, you will also be able to move the cursor between the Virtual 
Machine and the host OS without having to use the Right Ctrl key to recapture the cursor in the 
host. 

 
a.  From the Devices menu, select Insert Guest Additions CD Image. 

 

 
 

Figure 77 –Guest Additions Install 
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b. (CentOS 6.5 Only) Click the OK button to commence the installation script.   
 
NOTE:  If this prompt does NOT appear, you can right-click on the VBOXADDITIONS icon 
on the desktop and select Open with Autorun Prompt from the dropdown menu. 
 

 
Figure 78 – CentOS 6.5 Launch Guest Additions Script 

 

 

c. Click the Run button to execute the installation. 
 

 
 

Figure 79 – Run Guest Additions Installation 
 

 
d. (CentOS 7 only)  Enter the root password and click the Authenticate button. 

 

 
 

Figure 80 – CentOS 7 root Authentication 
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e. The Guest Additions should install and verify with no failures.  Press the Enter key to 
close the installation window. 

 

 
 

Figure 81 –Guest Additions Installation Complete 
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VirtualBox Shared Folders 
 
Once the Operating System has been installed, you must select a folder to share between the host and 
guest systems.  This folder is used to transfer files to/from the Virtual Machine and the Host system. 
 

1. From the VirtualBox main menu, select Devices -> Shared Folder Settings. 
 

 

Figure 82 – VirtualBox Shared Folders 
 

2. Right-click on Machine Folders and select Add Shared Folder. 

 

Figure 83 – Add Shared Folder 
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3. In the Folder Path box, click on the dropdown arrow on the right.  Select the Other entry to pop 
up a  Windows Explorer pane.  Browse to the location in Windows where you want to set up a 
shared folder and click OK in the Explorer pane.  Click the checkboxes for Auto-mount and Make 
Permanent.  Click the OK button. 

  

Figure 84 – Create Shared Folder 
 

4. The location of the shared folder in Windows is shown in the Path column.  The folder will Auto-
mount and Full Access is allowed.  The corresponding folder in the Linux VM is 
/media/sf_<Windows Folder Name>.  In the example shown, this corresponds to: 

/media/sf_VirtualBox_Share 

Click the OK button to close the panel. 

 

Figure 85 – Shared Folder Established 
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5. Shared folders are only available to user accounts that are also members of the group vboxsf. 
This means the user account created earlier must be added to this group.   

This can only be done in CentOS  from the command line.  In a Terminal with root privilege, 
enter: 

usermod –a –G vboxsf training 

To list the groups user training belongs to, enter: 

lid training 

 

Skip to list item 10. 

In CentOS 6.5  if you prefer to use a GUI, from the main menu select System -> Administration -
> Users and Groups.  You will be asked to enter the root user password for access to this utility. 

 

Figure 86 – User Account Selection from root 
 

6. Click the Groups tab.  From the menu, select Edit -> Preferences. 

 

Figure 87 – User Account Properties 
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7. Ensure the Hide systems users and groups box is unchecked.  Click the Close button. 

 

Figure 88 – Show All Groups 
 

8. In the User Manager panel, select the Groups tab.  Click the Group Name heading at the top of 
the column until that column is displayed in reverse alpha order.  This will place the vboxsf 
group near the top, as shown.  Double-click on the vboxsf entry. 

 

Figure 89 – vboxsf Group Selection 
 

9. In the Group Properties panel, click the Group Users tab.  Scroll down the list until you find the 
user name corresponding to the standard account you created.  Select the checkbox next to the 
user name.  Click the OK button to include the user name in the vboxsf group. 

 

Figure 90 – Add User to vboxsf Group  
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10. Close the User Manager panel.  Reboot the Virtual Machine.  The selected user name will 
belong to the vboxsf group on the next login.  To access the shared folder from the Virtual 
machine, open a File window and browse to: 

/media/sf_<sharename> 

In this example, the folder in Windows is named  VirtualBox_Share, so the sharename in Linux is 
sf_VirtualBox_Share, automatically mounted in the /media folder.  Any files in this folder are 
available to the Virtual Machine and the Host OS system. 

 

Figure 91 – Shared Folder in Linux 
 

  
 

Figure 92 – Shared Folder in Windows 
 

If you wish to mount a shared folder manually, open a Terminal window and elevate your 
privilege level to root with the su command.  The following command will mount the folder 
Virtualbox_Share at /mnt/Virtualbox_Share. 
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Xilinx Vivado/SDK Installation Tips 
 
Installing Vivado/SDK tools on a supported Linux system should be straightforward, but depending on 
the precise configuration of your development system, there could be some challenges to create an 
optimal environment.  This section outlines a few of the common issues that may be encountered. 
 
The Vivado 2014.4 Installer lists the Operating Systems that are officially supported by Xilinx.  The tools 
may run on other Linux distributions and versions, but there will likely be some manual configuration to 
be performed.  Installation on unsupported systems is beyond the scope of these notes. 
 

 

Install Vivado in the VirtualBox Linux VM 
 

1. Copy the all-OS version of the compressed Vivado installer to your account desktop. 
 

 
Figure 93 – Vivado Compressed Installer 

 
2. Open a terminal window and decompress the installer on your desktop.  It will create a new 

folder automatically in the current directory of your Terminal window. 
 
$ tar –xvzf ~/Desktop/<Compressed-Vivado-Installer-Name> 

 

 
 

3. Change into the new folder and execute the installer setup script.  You will need root privilege to 
install into the default directory of /opt/Xilinx (preferred). 
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4. Follow the instructions as shown in the Vivado installer GUI.  Note that if you wish only to 
install the SDK, select SDK Development Kit and Install Cable Drivers from the menu below. 

a. Accept all license agreements. 
b. Select the Vivado version you wish to install (or SDK Standalone). 
c. Select the Devices you need.  Be sure to select the SDK and cable drivers here, as by 

default they are NOT installed.   
 

 
Figure 94 – Vivado Device Selection 

 
d. Select the default directory for installation.  Depending on the size of your virtual disk, 

you may be space limited here.  You can delete the compressed installer from your 
desktop to free up 8+ GB of disk space if necessary. 

e. Obtain and Install a license for your tools. 
 

5. After installation, run the Xilinx settings script in a terminal window. 
 

 
 

6. You may optionally delete the entire folder where you decompressed the installer to free up 
additional disk space. 
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Install Missing Desktop Icons 
 

In some cases Vivado and/or SDK desktop icons may be missing.  You can manually create desktop 
shortcuts to the tools. 
 
1. Right-click in any open Desktop area.  Select Create Launcher from the pop-up menu. 

 

 
 

Figure 95 – Desktop Pop-up Menu 
 

2. Leave the Type as Application.  Enter the tool Name.  Click the Browse button to locate the tool 
executable.   Click the OK button to complete the Launcher.  The executables for the Xilinx tools 
are located by default at: 

 
Vivado:   /opt/Xilinx/Vivado/<version>/bin/vivado 
SDK:  /opt/Xilinx/SDK/<version./bin/xsdk 
DocNav: /opt/Xilinx/DocNav/docnav 
 

 
 

Figure 96 – Desktop Launcher Icons 

Install Missing Cable Drivers 
If you install Vivado in a standard user account and do not use root permission for the installation, you 
may find the cable drivers are not installed even though they were selected.  The drivers can be installed 
manually.   
 

1. Open a Terminal window. 
2. At the command prompt, enter: 

 
$ sudo 
<Vivado_install_dir>/data/xicom/cable_drivers/lin64/install_scri
pt/install_drivers/install_drivers 

 

 
3. You may also use the Terminal Window to install the device manager for the Linux kernel.   

 
$ sudo yum install udev 
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Install Libraries for DocNav 
Document Navigator requires a specific set of version-specific libraries to operate correctly.  If you are 
having problems with DocNav, the following instructions may be helpful. 
 

 
 

Figure 97 – DocNav Launch Error 
 
Required 32-bit Libraries 

 
fontconfig.i686 
libXext.i686 
libXrender.i686 
glib2.i6 
libpng.i686 
libSM.i686 
libstdc++.i686 

 
The libraries may be installed but DocNav might require a new version.   The updates can be performed 
from a command line terminal with root privilege.  Use the YellowDog Updater (Modified) to update 
each library.  There are two versions of the libraries, one for 64 bit (.x86_64) and one for 32-bit (.i686).  
You must update the 64 bit library first and then add the 32-bit library, as follows: 
 

$ sudo yum update <library_name_without_extension> 
$ sudo yum install <library_name_with_extension> 

 

 
 

 
Document Navigator should now operate correctly. 
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Multi-lib Version Error (installing Libraries) 
If you receive an error similar to the following: 
 

 
 
This is an indication that there is a conflicting update required between the 64-bit and 32-bit versions of 
the packages.  To resolve the issue, you must first update the 64-bit library, then install the 32-bit 
version.   
 
 

$ sudo yum update <library_name_without_extension> 
$ sudo yum install <library_name_with_extension> 

 
For example, if the error is issued for libselinux.i686, enter the following commands at the root prompt: 
 

yum update libselinux  (update 64-bit package) 
yum install libselinux.i686  (install 32-bit package) 

 

Windows 260 Character Path Limit 
If you are using the Vivado Design Suite on a Windows-7 host, you may run into issues resulting from 
Vivado pathnames exceeding the maximum allowed.  Vivado projects create a very deep file hierarchy, 
and it becomes very easy to violate the Windows limit if the project is not extracted near the root of the 
drive.   This can even happen when the archive is decompressed, depending on where you choose to 
place the project in your existing file hierarchy. 
 
It is not always convenient to place every Vivado project at the root of a drive.  To work around this 
limitation, the recommended procedure is to place the Vivado archive in a shared folder on your host 
machine, then use Windows Explorer to map a network drive to the directory where the archive will be 
decompressed.   This allows the Vivado project to be mapped to the root of the virtual (mapped) 
directory, eliminating any path issues. 
 
Vivado also makes use of the Windows temp folder, which may be located several folders removed from 
the root drive, and this can also cause problems.  You can create your own temporary directory in 
C:\temp, and force Vivado to use the new folder with the following TCL: 
 

set_param “project.customTmpDirForArchive”  C:/temp 
 
For further information, see the Xilinx answer record at:  
 

http://www.xilinx.com/support/answers/52787.html. 
 

  

http://www.xilinx.com/support/answers/52787.html�
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CentOS Installation Tips 

Open Folders in Browser Mode 
By default in the CentOS Nautilus GUI, file folders are opened in separate windows, as shown below. 
 

 
 

Figure 98 – VirtualBox Network Properties 
 
If you would prefer the operation to be more akin to Windows Explorer, where you can move between 
folders in the same window as shown here, perform these steps: 
 

 
 

Figure 99 – View Folders in Browser 
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1. From an open folder window menu, select Edit -> Preferences. 
 

 
 

Figure 100 – Edit Folder Preferences 
 

2. Select the Behavior tab and check the box to Always open in browser windows.  Click the Close 
button to save the new setting. 

 

 
 

Figure 101 – Select Browser Display Option 
 

3. Close the folder window, and open a new folder window.  All subsequent open folder requests 
will use the browser format. 
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Set Standard Account for sudo 
 
Many installation and configuration operations must be performed from a process with root privilege.  
While the su command (with root password) is always available, it is often more convenient to use the 
sudo command to allow root privilege to the current operation only.  To allow a standard user account 
access to sudo, a configuration change must be made to the Linux system.  When authorized for sudo, a 
standard account need only confirm with the account password, not the root password. 
 
This example uses a standard account named training.  You can use any standard account on your 
system. 
 

1. In the CentOS guest operating system, open a terminal window through the 
ApplicationsSystem ToolsTerminal menu item. 

 
 

Figure 102 – Launching the CentOS Terminal from the Desktop 
  



VirtualBox and VM Creation  Vivado®/SDK 2014.4 
 

 
 56 February 2015 

2. Take on root privileges by running the superuser elevation command su and entering the root 
password. 

$ su 
 

 
Figure 103 – Elevating to Superuser Privileges 

 
3. Use visudo text editor to edit the /etc/sudoers file. 

# visudo 
 

4. Add the training user to the sudoers list by inserting the following line to the users section of 
the sudoers file as shown below.  The users section is located towards the end of the file. 

training  ALL=(ALL) ALL 
 
To add text from within the vi editor, press the “i” key on the keyboard to use vi insert mode. 
 

 
Figure 104 – Adding training Account to /etc/sudoers File 

 
5. Exit the vi editor and save changes to the sudoers file by using the write-quit key sequence: 

<ESC> :wq 
 

6. The training user will now have sufficient privileges to do important systems tasks using the 
sudo command. Exit the superuser mode by typing exit at the command prompt. 

# exit 
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No Bootable Media During OS Installation 
 
If you power down an empty Virtual Machine prior to installing the operating system, you may get an 
error on power-up that there is no bootable media found.   Correct this by following the instructions 
below.  

1. If shown, click the  icon to close the Auto capture Keyboard warning, or the  icon to 
suppress the message permanently. 

 

Figure 105 – Auto Capture Keyboard Warning 
 

2. VirtualBox informs you that there is no bootable media.  This is correct as there is no OS 
installed at this point. 

 

Figure 106 – No Bootable Media Warning 
 

To locate the OS image downloaded earlier to your host system, select Devices -> CD/DVD 
Devices -> Choose a virtual CD/DVD disk file. 

 

Figure 107 – Select a Disk to Install 
 

3. Browse to the download location for your OS image.  Select the image and click the OK button. 

 

Figure 108 – Browse to the OS Image 
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4. From the main VirtualBox menu, select Machine -> Reset to boot from the OS image.   
 

 
 

Figure 109 – Reset the Virtual Machine 
 

Network Bridging 
When VirtualBox is installed with its default options, the networking is set up to use Network Address 
Translation (NAT).  This allows your Virtual Machine complete outgoing access to your LAN and/or the 
Internet, but it assigns an internal IP address that may not be compatible with your LAN and the IP 
address of your host system. 
 
If you would like your Virtual Machine to accept an address from a local DHCP server, you can change 
the default network type to Bridged.  This will make the Virtual Machine available to any other 
connected device on the same subnet on your LAN. 
 

1. From the main VirtualBox menu in a running Virtual Machine, select Machine -> Settings. 
 

 
 

Figure 110 – Access Virtual Machine Settings 
 

2. Select the Network entry in the left panel.  Select the tab for your NIC (typically Adapter 1) and 
expand the dropdown menu for the Attached to field. 
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Figure 111 – Network Attachments 
 

3. Select Bridged Adapter from the dropdown menu and click the OK button to save the changes.  
Wait a few seconds for your Virtual Machine to request an address from the local DHCP server.  
Once complete, the VM will now have an address on your local subnet, accessible to all devices 
on your LAN. 

 

  



VirtualBox and VM Creation  Vivado®/SDK 2014.4 
 

 
 60 February 2015 

CentOS 6.5 Network Troubleshooting 
1. When you first log in as a standard user, check the status of your network connection by 

observing the icon indicated in the figure below.  If the icon appears with a small X as shown, 
there is a problem with the network connectivity from VirtualBox. 
 

 
 

Figure 112 – Network Connectivity Issue 
 
Before continuing, ensure that you have network access from the host system.  If successful, 
continue with the configuration steps below. 

 
2. Right-click the networking icon and ensure Enable Networking is selected.  Select Edit 

Connections. 
 

 

Figure 113 – Enable Networking 
 

3. Select System eth0 and click the Edit button (You may or may not have Auto eth1 and other 
connections depending on your system hardware). 

 

Figure 114 – Edit Network Connection Properties 
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4. Ensure the boxes for Connect automatically and Available to all users are both checked.  Click 
the Apply button at the lower right of the panel (not shown).  You will need the root password 
to complete the operation. 

 

Figure 115 – Eth0 Properties 
 

5. To prevent any interference from additional Ethernet devices, during trouble shooting uncheck 
the Connect automatically box in all other adapter entries and click the Apply button. 

 

Figure 116 – Eth1 Properties 
 

6. Click the Close button to exit the Properties panel. 
 

 
 

Figure 117 – Close Network Properties Panel 
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7. In the main VirtualBox menu, select Devices -> Network -> Network Settings. 

 

 

Figure 118 – VirtualBox Network Settings 
 

8. Ensure the attachment type is NAT, the correct physical Network Interface Card is selected for 
the Adapter Type and the Cable Connected box is checked.  Click the OK button. 

 

Figure 119 – VirtualBox Network Properties 
 

9. If Networking is still not active, reboot the Virtual Machine. 
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Set up the TFTP Server (PetaLinux) 
The u-boot boot loader can be configured to use a TFTP server to download a Linux kernel image to a 
target board for testing.   PetaLinux automatically copies the image files to the root of the TFTP server 
folder, so it is useful to have this set up even if when primarily booting from an SD card.   
 
1. Log in to your Linux host , open a Terminal window and use the su command (or sudo) to elevate 

your privilege level.   
 

2. Create a directory in the root of your Linux host where the PetaLinux build files will be copied.  By 
default this is ‘/tftpboot’.  Be sure to give this directory full access permissions for all users: 
 
# mkdir /tftpboot 
# chmod 777 /tftpboot 

 
3. By default the TFTP server is disabled.  To enable the TFTP server, edit5

 

 /etc/xinetd.d/tftp file using 
root privileges, replacing the word yes on the disable line with the word no.  Also verify the correct 
directory is specified  as /tftpboot on the server_args line.  Save the file and exit the editor. 

  
Figure 120 - TFTP Configuration File 

 
4. Restart the daemon by invoking the run configuration script:  

 
# /etc/init.d/xinetd restart 

                                                           
5 You may use any installed editor to make the changes, or you may install another editor if you wish.  Note that if 
you choose to use gedit, you may see warning messages as it is invoked, but these do not affect gedit operation. 
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5. This command will stop and then restart all of the services managed by the daemon on your Linux 
system.  In addition to the restart command, you can also issue stop and start commands this way. 

Note:  If your Linux system is running Internet services on which other systems depend, restarting 
the daemon will cause a slight interruption in those services. 
 

6. CentOS Linux has one more level of security that may prevent the TFTP service from accessing files 
in the /tftpboot directory.   In a terminal window, enter:   
 

ls –laZ /tftpboot 
 

 
 
The selinux context for files in the /tftpboot directory must be: 
 

unconfined_u:object_r:tftpdir_t:s0 
 

7. If the selinux context is incorrect, run the following command in a terminal window: 
 

sudo restorecon –r /tftpboot 

 
 
8. The selinux file context should now be correct. 

 

 
 
The TFTP server will now be started on your system and should respond to incoming TFTP requests. 
 
If you manually locate files in /tftpboot, always copy files instead of moving them. Moved files preserve 
existing permissions, including the selinux context that may not be compatible with the requirements 
for the /tftpboot directory.  
 
Additional information is available at: 
 

https://www.centos.org/forums/viewtopic.php?t=7985 
 
Note that TFTP server requests may be blocked by Firewall software or router protection, and may not 
accessible from outside the local sub-net without appropriate network configuration that is specific to 
your LAN.   If you are using TFTP, it is best to have a DHCP server running on your Linux host, and to 
connect the Ethernet cable directly between the host and target. 

https://www.centos.org/forums/viewtopic.php?t=7985�
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